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WORKFLOW MANAGEMENT OVERVIEW

The Workflow Management application in AuthorSpace gives you the ability to automate and track the 

workflow process for adding or modifying content in your environment. With Workflow Management, 
you will be able to:

• Define workflow steps for the approval process

• Identify content associated with each workflow 

• Assign resources, duration, and start dates for each of the approval steps

• Automatically generate Welcome e-mails to the assigned resources to let them know that they 
have a task to perform 

• Monitor and report on the progress in approving each piece of content

• Modify active workflows to match changes in resources or schedule 

• Reuse a workflow the next time you want to review content, making modifications to any part of 
the workflow definition as needed

For each piece of content in review, when one step in the process is completed in Workflow Manage-
ment, the next step in the process automatically starts. 

With Workflow Management, you will no longer have to rely on spreadsheets, send e-mails, and make 
phone calls to find out where you are in the process. Issues in the process are immediately identified so 
you can, if necessary, take corrective action. 
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CREATING WORKFLOWS

On the Workflow List page you can perform any of the following actions:

• Add a new workflow

• Edit an existing workflow

• Copy an existing workflow to create a new workflow

• Assign content to an existing workflow that has all required fields defined

• Delete workflows that do not have activated content 

Workflow List
When you launch Workflow Management from AuthorSpace, the first page you see is the Workflow tab. 
On this page, you can create new workflows and make modifications to existing workflows.   

Click New Workflow to create a new workflow. 

Open an existing workflow by clicking on the workflow name. Hospital Administrators or Environment 
Managers or Administrators will be able to create and edit workflows. Other AuthorSpace users can only 
view the workflow definition.

Workflow Definition

When you create a new workflow you are presented with a blank workflow definition page with 
the fields Workflow Name and Notes, and a grid that initially displays four blank workflow steps. 

Enter a unique workflow name to describe the workflow. A workflow name is required. Notes 
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are optional.

Workflow Steps

For each step in the workflow, enter a step name and duration. The step name must be unique for this 

workflow. Duration is for calendar days, including weekends and holidays. If your process requires more 
than 4 steps, click Add a Step. There’s no limit to the number of steps in a workflow.

Click Save to save additions and changes you have made to the workflow. When you click Save, missing 
elements are indicated in a message on the page and any step that has no information will be removed 
from the Step grid. 

Assign Users and Step Owner

For every step, you will need to assign at least one AuthorSpace User or ViewSpace Reviewer. There is no 
limit to the number of people you can assign to a step. 

Click Assign People to bring up the Assign People to Step page. After adding a person to the step, the link 
on the step changes from Assign People to Edit People. 
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If the Reviewer you are looking for has not been defined, you can create the person here.

You can optionally designate an AuthorSpace User as the Step Owner. This person will have the authority 
to indicate that the content has completed this step. Hospital Administrators or Environment Managers 

or Administrators can complete steps without being designated as a Step Owner.

Welcome Memo

When a step starts, the assigned Users and Reviewers can receive an e-mail listing the content that they 
have been assigned. The Welcome Memo in the workflow step allows you to define a customized subject 
and message. Standard text formatting is available when creating your Welcome Memo. In the welcome 
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e-mail, your message will appear before the content list when the content has started this step. 

Welcome Memos are optional.

Completing the Workflow Definition

Before you can assign content to a workflow, all required fields must be filled in. For each step, the 
required fields are: Step Name, Duration, and Assign People. 

At any time while creating a workflow, you can click Save. After saving, you will see a message on the 
workflow page indicating any missing items required in order to assign content. Content can only be 

assigned and activated on completed workflows. You will also note that the Assign Content button or link 
is not active until all required fields for all workflow steps have been added.  

A completed workflow must have at least one step and each step must have a unique step name. Each 
step must also have a valid duration and at least one user or reviewer assigned to it. 

Copying a Workflow

To make a copy of a workflow, click the Copy link on the Workflow List page. This creates an exact copy of 

the workflow definition, including steps, duration, assigned users, and welcome memos. Click the new 
workflow link on the Edit Workflow page and change the Workflow Name. You can make other modifica-
tions to the new workflow definition and then assign content.  

Deleting a Workflow

You can delete a workflow only when it has no activated content. The link is disabled if the workflow has 
activated content. For a selected workflow, click the Delete link on the Workflow List page. 
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If your workflow has activated content, the Delete link is disabled.  To enable the Delete link, you must 
first remove all the activated content. Use the Track Progress Content View to remove the content from 

the workflow.
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ASSIGNING AND ACTIVATING CONTENT

There are two ways to get to the Assign Content page for a workflow: 

• Click the Assign Content link on the Workflow List page 

• Click Assign Content from the Edit Workflow page

The Assign Content link and button are disabled if the workflow definition is incomplete.

Select Content

On the Assign Content page is the list of folders where your content lives in AuthorSpace. When you 
select a folder, the order sets and plans of care display in the Content List pane. Select the content you 
want to activate and move it to the Assigned Content pane by clicking Add to Workflow. You can remove 
content by clicking Remove from Workflow.

Once you are happy with the content selected in the Assigned Content pane, the next step is to select the 
start date to begin the workflow process.  

Select Start Date and Activation

On the Assign Content page, click Select Start Date and the Select Start Date page appears. Choose the 
date to start the workflow process. Each step of the workflow is shown with its start and end date calcu-
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lated based on the start date just selected and the durations entered as part of the workflow definition 
process. You can use different start dates to go through what-if scenarios.

You can choose a date in the past. This is useful if you are migrating content going through your current 

process outside of the Workflow Management application. When you backdate the start date, any steps 
with an end date prior to today will be marked as completed on that date. Any steps with a start date 
prior to the current date will be marked as starting on that date. Welcome e-mails are not sent for any 
steps started when you backdate the activation.

Click Activate to start the workflow process. You will get a message on the Workflow Activated page and 
a link to the Track Progress tab. 
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TRACKING PROGRESS

After you have activated content, click the Track Progress tab to monitor the progress of content through 

the workflow. The default graph view displays all active workflows and progress made in the workflow.  
The grid view on the bottom part of the page defaults to the Content View.  The default Content View 
includes activated content that is In Progress, Late, or Blocked.

There several filter features on this page to narrow and change the view. 

Workflow Status with Content View

Clicking on the Workflow Name (for example, Cardiology) will display the Step Graph with the steps for 
the workflow.  The content view will display all activated content for the workflow.

 Clicking the following screen elements refreshes the content view:

- Workflow Status Bars:

o In Progress (green bar) displays In Progress content for the selected workflow

o Late (red bar)  displays Late content for the selected workflow

o Blocked (rust bar)displays Blocked content for the selected workflow
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o Completed (purple bar) displays Completed content for the selected workflow

o Not Started (gray bar)displays Not Started content for the selected workflow

- Legend Status Bars:

o In Progress (green bar) displays In Progress content for all workflows 

o Late (red bar) displays Late content for all workflows

o Blocked (rust bar) displays Blocked content for all workflows

o Completed (purple bar) displays Completed content for all workflows

o Not Started (gray bar) displays Not Started content for all workflows

Step Status with Content View

The default view for the Step Status graph displays the status of all steps for all workflows. When a single 

workflow is selected, the steps are listed in sequential order. When the context is all workflows, the steps 
are listed in alphabetical order. The default is to view all workflows, as shown here: 
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The view for a single workflow is shown here:  

Clicking the following screen elements refreshes the content view:

- Step Name displays content for this step with any status

- Step Status Bars:

o In Progress (green bar) displays In Progress content for the selected step 

o Late (red bar) displays Late content for the selected step 

o Blocked  (rust bar) displays Blocked content for the selected step 

o Completed  (purple bar) displays Completed content for the selected step 

o Not Started (gray bar) displays Not Started content for the selected step

- Legend Status Bars:

o In Progress (green bar) displays In Progress content for all steps for the workflow(s)

o Late (red bar) displays Late content for all workflow steps for the workflow(s)
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o Blocked (rust bar) displays Blocked content for all workflow steps for the workflow(s)

o Completed (purple bar) displays Completed content for all workflow steps for the work-

flow(s)

o Not Started (gray bar) displays Not Started content for all workflow steps for the work-

flow(s)

You can hide the graph by clicking on the ^ in the middle of the blue bar. This will hide the graph and dis-

play the grid in the full screen. To bring back the graph, click any part of the blue bar.

Content View

The Content View displays activated content grouped by workflow. Click the + next to a workflow name 
to expand and display the content for that workflow. By default the grid view shows activated content fil-

tered by step status of In Progress, Late, or Blocked. You can use the Workflow Status or Step Status 
graph to re-filter the content as you desire. See the preceding list for details on what filters can be 
applied using the graph.

Click the Expand link to expand all workflow groups. Click the Collapse link to collapse workflow groups.
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You can remove all filters to see all steps for activated content by clicking the Clear all filters link. Individ-
ual filters can be removed by clicking the X preceding the filter name. Place the cursor over the filter 

name to display the filter values applied.

The Content View below displays all the steps for the content and the individual step status. The current 
step (In Progress, Late, or Blocked) is outlined in color according to its status.
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The Content View is always grouped by workflow. The workflow name is shown in the dark blue bar and 
indicates the start of the group. Here is a list of the columns in this view:

Original Start and End Dates are optional columns. To display these columns in the Content View hover 
over any column header, click the drop-down arrow, and choose Columns. You can choose one or both 

Column 
Name

Description

Content
Content name, its folder path and current status. Hospital Administrators 
or Environment Managers or Administrators can remove content from the 

workflow by clicking Remove.
Step Step name
Status Step status

People

Link to view or edit the AuthorSpace Users and ViewSpace Reviewers cur-

rently assigned to the content for this step. Hospital Administrators or Envi-
ronment Managers or Administrators can add or remove users assigned to 
the content for this step. This does not alter the workflow definition.

Planned Start 

Date this step is/was currently scheduled to start. Hospital Administrators 
or Environment Managers or Administrators can edit Planned Start Dates 

for steps that have not yet started.  Available dates are limited by the 
planned end date for the step.

Planned End 

Date this step is/was currently scheduled to end. Hospital Administrators 
or Environment Managers or Administrators can edit Planned End Dates for 
steps which are In Progress, Late, or Blocked. Available dates are limited by 
the planned dates for the following step. 

Actual Start Date the step started.
Actual End Date the step ended.

Original Start
Optional column - Date the step was originally scheduled to start when the 
content was activated. 

Original End
Optional column - Date the step was originally scheduled to end when the 

content was activated.
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dates to include in the grid view.

When you export the Content View, these fields will be included in the export regardless of whether you 

added the fields to the display.

People View

The People View initially displays activated content by collapsed User. Click the + next to a name to view 
the content assigned to that person. By default, the view shows activated content filtered by In Progress, 
Late, or Blocked step status.

Click the Expand link to expand all User groups. Click the Collapse link to collapse User groups.
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The People View is always grouped by user name. The user name is shown in the dark blue bar and indi-
cates the start of the group. Here is a list of the columns in this view:

People View with Workflow Status Graph

When Track Progress shows the People view with the Workflow Status graph, clicking the following 
screen elements refreshes the People view:

- Workflow Name displays the people assigned to content for the workflow

- Workflow Status Bars:

o In Progress (green bar) displays people assigned to In Progress content for the selected 

workflow

o Late (red bar) displays people assigned to Late content for the selected workflow

o Blocked (rust bar) displays people assigned to Blocked content for the selected workflow

o Completed (purple bar) displays people assigned to Completed content for the selected 

workflow

o Not Started (gray bar) displays people assigned to Not Started content for the selected 

workflow

- Legend Status Bars:

Column 
Name

Description

User User name. Click column header to filter by name

Workflow
Workflow name for the assigned content. The default view shows the 
workflows assigned to the user in alphabetical order.

Content Content name, its folder path, and current status
Step Step name
Status Step status
Planned End Date this step is/was scheduled to end. 

Review Date
Date the content was reviewed by the assigned user. The review date is 
captured when an assigned user clicks Review Complete on the View 
page for the content in AuthorSpace or ViewSpace.
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o In Progress (green bar) displays people assigned to In Progress content for all workflows 

o Late (red bar) displays people assigned to Late content for all workflows

o Blocked (rust bar) displays people assigned to Blocked  content for all workflows

o Completed (purple bar) displays people assigned to Completed content for all workflows

o Not Started (gray bar) displays people assigned to Not Started content for all workflows
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People View with Step Status Graph

Clicking the following screen elements refreshes the content view:

- Step Name displays the people assigned to any content for the step

- Step Status Bars:

o In Progress (green bar) displays people assigned to In Progress content for the selected 

step

o Late (red bar) displays people assigned to Late content for the selected step

o Blocked (rust bar) displays people assigned to Blocked content for the selected step

o Completed (purple bar) displays people assigned to Completed content for the selected 

step

o Not Started (gray bar) displays people assigned to Not Started content for the selected 

step

- Legend Status Bars:

o In Progress (green bar) displays people assigned to In Progress content for the work-

flow(s) 

o Late (red bar) displays people assigned to Late content for the workflow(s)

o Blocked (rust bar) displays people assigned to In Progress content for the workflow(s)

o Completed (purple bar) displays people assigned to Completed content for the work-

flow(s)

o Not Started (gray bar) displays people assigned to Not Started content for the work-

flow(s)

Sorting and Filtering Grid Views

You can sort on any column in the grid view. Click a column header to sort in ascending order. Click again 
to sort in descending order. Sorting occurs within a workflow or user group. You can also hover over a 
heading and click the drop-down arrow and click either Sort Ascending or Sort Descending. 
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Most filtering can be accomplished by clicking on the graphs. Filtering is also available by clicking on the 
column header. 

To filter on Step or Status, click the column header arrow to display the filter option.  

To filter on any of the date columns, click the column header arrow to display the filter options.  Choosing 

one of the filter options displays the calendar where you can select a date.
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On the People View, to view content by user name, click the User column header. The filter option dis-
plays a text box. Type in the text box the name you’re looking for. 

Filter indicators appear whenever filters are applied. Hover over the indicator to see the specific filters 
applied. The filters can be removed by clicking the X preceding the filter name.

Filters applied to one grid view remain in place when switching to the other view. For example, if you fil-
ter by workflow name on the Content View, when you switch to the People View, the People View is fil-
tered by the workflow name as well.

Exporting

Export is available for both Content and People views. The Export link creates a file named Content.csv or 

People.csv. You can choose to open the file in Microsoft (MS) Excel or download the file.

The export file includes the rows in the grid view based on the filters currently applied.

Use MS Excel to format and print any reports needed.
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COMPLETING WORKFLOW STEPS

Hospital Administrators, Environment Managers, and Administrators are authorized to complete steps. 

Other AuthorSpace users are also authorized to complete steps if they have been designated as the Step 
Owner.

Select Content to Complete

Click the Step Management tab to see the grid that lists the content currently In Progress or Late and eli-
gible for completion. AuthorSpace users who are not Hospital Administrators, Environment Managers, or 

Administrators will only see the content in steps where they have been designated step owner.

The default view for the grid is by Workflow Name and collapsed. Click the + to view the content list for a 
workflow. You can also apply filters to any of the columns in the grid as described above in Sorting and 
Filtering Grid Views.
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Columns on the Step Management tab are:

Completing a step captures the Actual End date shown in Track Progress on the Content View. 

STARTING STEPS

When completing a step, the next step is automatically started when: 

• There are no Reviewers assigned to the step (for example, only AuthorSpace Users are assigned 
to the step)

• Reviewers are assigned and the content is in Review status.

The next step cannot start if there are Reviewers assigned and the content is not in Review status. In this 

case, the step status is Blocked and welcome e-mails are not sent.

Content activated with a future start date will start on that date. If the first step has Reviewers assigned, 
be sure the content is in Review status. Otherwise the step status will be Blocked.

Column Description
Workflow Workflow name
Content Name of content with its folder path
Step Step name
Status Step status
Planned End Date the step is currently scheduled to end
Content Status Content status
Step Owner Name of step owner, if any
Complete Step Checkbox to be selected when the content is completed
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Welcome E-mail

If the step was defined with a Welcome Memo, an e-mail will be sent to all assigned AuthorSpace Users 

and ViewSpace Reviewers on the day the step starts. The e-mail will include the message defined for the 
step with a list of content to be reviewed.   Review requests generated from Workflow are sent from 
“ViewSpace”.  Review requests generated from AuthorSpace continue to be sent from “AuthorSpace”. 

For steps with assigned Reviewers, the content is listed as links to the ViewSpace review page.

For steps without Reviewers, the content is listed with its folder path.

Blocked Content

Content has a status of Blocked if there are Reviewers assigned and the content is not in Review status 
when the step is due to start.

Blocked content will show on both the Workflow and the Step Status graphs. Click the Blocked legend bar 
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on either graph to see the Blocked content list. Hover over the Blocked status on a content row to see 
why it is blocked.

When the content status has been updated to Review in AuthorSpace, a background process will update 
the step status. This process runs periodically throughout the day, about every 5 minutes.
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MANAGING USERS AND REVIEWERS

AuthorSpace Users and ViewSpace Reviewers are listed together on the People tab. First Name, Last 

Name, E-mail Address, and Role are listed for each person.

Creating and Editing Reviewers

Click New Reviewer to create a ViewSpace Reviewer. First name, last name, and a proper e-mail address 
are required to add a Reviewer. The e-mail address must be unique. Only Hospital Administrators, Envi-
ronment Managers, and Administrators are allowed to create or edit Reviewers.

You can edit ViewSpace Reviewers by clicking Edit in the Actions column. Again the e-mail address must 

be unique.

PREPARING DISTRIBUTION LISTS/CONTACTS FROM OUTLOOK FOR UPLOAD INTO WORKFLOW 
MANAGEMENT

Exporting Distribution Lists

Outlook supports the export of individual distribution lists. However, if you wish to upload multiple distri-
bution lists to Workflow Management, you will need to export each distribution list separately. Then, you 
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can either upload them individually or combine the lists into a single spreadsheet for upload.

Note that Outlook will only allow you to export those distribution lists for which you are the owner or 
administrator. If you need to upload other distribution lists into AuthorSpace, you will need to ask the 

respective owners/administrators to do the initial export from Outlook for you.

Export File from Outlook

1. From the Home tab, select Contacts and double-click the desired Distribution List to open it.

2. From the File tab, select Save As and then select Text Only (*.txt) from the Save as type drop-

down.
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Prepare File for Upload into Workflow Management

1. Launch Excel. From the File tab, select Open and then double-click the file you just exported 
from Outlook. In order for your file to appear, you will need to ensure that the drop-down to the 
right of File name shows either All Files (*.*) or Text Files (*.prn;*.txt*;*.csv).
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2. In the Text Import Wizard - Step 1 of 3, leave the default selection Delimited and click Next.

3. In the Text Import Wizard - Step 2 of 3, leave the default selection option of Tab checked. Also 
check Comma and Space. (Note: When you check Space, the box before Treat consecutive 
delimiters as one will also be checked.) Click Next.
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4. In the Text Import Wizard - Step 3 of 3, leave the default selection General and click Finish.

5. You will need to format the spreadsheet that subsequently appears to align exactly with the 
following heading conventions:

- Column A: Last Name

- Column B: First Name

- Column C: Email Address

- Column D: Distribution List

Column D should be populated with the full distribution list name. Note that the name is split 
across multiple columns in the example below.

Other requirements to be aware of:

- Empty rows are not allowed.

- Extra spaces within a cell are not allowed.

To format the above spreadsheet, you would need to:

1. Delete rows 1-4.
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2. Insert a row at the top of the spreadsheet.

3. Type the following into the appropriate cells.

a. Cell A1: Last Name

b. Cell B1: First Name

c. Cell C1: Email Address

d. Cell D1: Distribution List

4. Type the full name of the distribution list into column D beneath the header and copy and 
paste it into the rest of the populated rows.

The final correctly formatted spreadsheet should look like this:

6. Save the correctly formatted spreadsheet as a .csv file.
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7. If you get any warning messages, click OK or Yes.

That’s it! Your distribution list is now ready to be imported into Workflow Management. If you choose to 

combine multiple distribution lists into a single .csv file for upload and a single contact belongs to more 
than one distribution list, that contact should be listed in multiple rows with different distribution list in 
each row under column heading Cell D1:

If you upload any distribution lists that do not already exist in Workflow Management, AuthorSpace will 
automatically create the distribution list and tie the respective reviewer records to the indicated distribu-

tion list.

Exporting Contacts

With this enhancement, you also can choose to export all of your Outlook contacts and upload them into 
Workflow Management as reviewers (users with AuthorSpace accounts still need to be created in the 
usual manner). As with the distribution lists, you need to be the owner or administrator to perform the 
export.
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Export File from Outlook

1. For Outlook 2010, from the File tab, select Options. 

For Outlook 2003/2007, from the File tab, select Import and Export.

2. For Outlook 2010, from the Outlook Options window, select Advanced and click Export.
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For Outlook 2003/2007, this step is unnecessary.

Note: The rest of the steps are identical.

3. From the Import and Export Wizard, select Export to a file and click Next.

4. Select Comma Separated Values (Windows) and click Next.

5. Select the Contacts folder and click Next. Remember that you can only export Contacts for 
which you are the owner or administrator.
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6. Click Browse to choose a destination folder. Enter the File name and click OK; them click Next.
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7. Leave the default selection checked and click Finish.

Prepare File for Upload into Workflow Management

1. Launch Excel. From the File tab, select Open, and then double-click the file you just exported 
from Outlook. For your file to show up, you will need to make sure that the drop-down to the 
right of File name shows either All Files (*.*) or Text Files (*.prn; *.txt; *.csv).

2. Remove all unnecessary columns from the file. The required columns are First Name, Last 
Name, and Email Address. In the example shown below, only columns B, D, and BF are neces-
sary. Note that other Outlook versions may extract the data into different columns.
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3. Format the spreadsheet so that it aligns exactly with the following heading conventions:

- Column A: Last Name

- Column B: First Name

- Column C: Email Address

- Column D: Distribution List

Other than the heading, column D may be blank; all other columns must be populated. If you 
have distribution list information, you can either enter it here or export it and upload it sepa-
rately to Workflow Management.

The final correctly formatted spreadsheet should look like this:
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4. Save the correctly formatted spreadsheet as a .csv file.

5. If you get any warning messages, click Yes.
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IMPORT E-MAIL AND DISTRIBUTION LIST FROM WORKFLOW MANAGEMENT

Zynx Health is pleased to announce the launch of a new feature that provides a file-based import of Out-
look contacts into Workflow Management.

Launch Workflow Management

1. Log in to AuthorSpace.

2. Click Workflow Management.

Navigate Contacts List in Workflow Management

1. Click the People tab.

Choose the Import File to Load

Note: For instructions on how to prepare the file, refer to Export/Import instructions in the Preparing Dis-

tribution Lists/Contacts From Outlook for Upload Into Workflow Management section.
Page 42



1. Click Import Reviewers.

2. Click Choose File.

3. Browse for the .csv file saved on your computer.

4. Click Open or double-click on the file.
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5. Click Import.

Import Validation

Review and Fix Validation Errors

Note: Refer to Export/Import instructions in the Preparing Distribution Lists/Contacts From Outlook for 

Upload Into Workflow Management section.

1. Click the View validation errors link.

2. Click Save.

3. The system will prompt you to click Open or Save.
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4. Open the file from its saved location.

Note: Below is the confirmation page after a successful import:

Create New Distribution List in Workflow Management

1. Click New Distribution List.
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2. Type a name in the Distribution List field.

3. Select the members in the left page to be associated with the new Distribution List.

4. Click Add to Distribution List in the middle of the screen.

5. Click Submit.

Modify and Existing Distribution List

Note: There are two ways to associate a reviewer to a Distribution List: here and from New/Edit 
Reviewer.
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1. Find a Distribution List to modify and click Edit in the Actions column.

2. Modify the member of the Distribution List by:

   a. Selecting the member from either the left or right pane

   b. Clicking Add to Distribution List or Remove from Distribution List.

3. Click Submit.

Delete Distribution Lists and Reviewers from the People Tab

1. Find a Reviewer or Distribution List to be deleted.

2. Click the Delete link in the Actions column.
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3. Click Delete.

4. A green banner appears briefly to confirm the request has completed successfully.

Note: The process is the same for deleting a reviewer.

Associate a Reviewer to Multiple Distribution Lists

Note: This action can be performed while creating or editing a reviewer.

1. Click New Reviewer from the People tab.

2. Enter the New Reviewer information (first name, last name, email address).

3. Click the checkbox for the desired Distribution List.
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4. Click Save.

Modify a Reviewer’s Association to a Distribution List from the Edit Reviewer Menu

1. Find the reviewer from the People tab.

2. Click the Edit link.

3. Edit Reviewer page appears.

4. Click the Distribution List checkboxes to add or remove (existing associations are already 
checked).
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5. Click Save.

Assign a Distribution List to Step

1. Select the Distribution List from the left pane.
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2. Click Add to step.

3. Click Submit.

Distribution List as a Search Filter

Searching for Members of a Distribution List Using Distribution List as the Filter

1. Click on the filter drop-down.

2. Select Distribution List.

3. Type the name of the Distribution List in the search field.

4. Click the magnifying glass icon or the Enter key.

Note: The results are showing all members associated to the filtered Distribution List.
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Searching for a Distribution List Using “Last Name” as the Filter

1. Click on the filter drop-down.

2. Select Last Name.

3. Type the name of the Distribution List in the search field.

4. Click the magnifying glass icon or the Enter key.

Note: The results are showing all of the existing Distribution Lists that match the search string.
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EDITING WORKFLOWS

Edit a workflow by clicking the workflow name from the Workflow List on the Workflow tab.

Minor Edits

When changing a workflow name or step name, the new name will immediately appear in Track Progress 
for activated content.

Changing a step’s duration, assigned people, or welcome memo does not affect content already acti-
vated. Only content activated after the change will use the new step definition.

Delete and Re-sequence Steps

Deleting or re-sequencing steps is allowed but has serious consequences if the workflow already has acti-
vated content.

If the workflow does not have activated content, delete an unneeded step by clicking the appropriate X 

on the right side of the step.
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Restore the step by clicking the + on the right side of the step.

To re-sequence a step, click and hold the group bar for the step and drag and drop the step to the new 

position.
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Effects of Deleting Steps with Active Content

If a workflow has activated content, the content will be deleted because it will no longer conform to the 

workflow definition. When saving this change, you are given the option to export the content. This will 
create a text (.csv) file that can be saved locally and used with MS Excel. You can reactivate the content 
currently in progress to restore it to its current step using the revised definition. The text file contains all 
the information you will need to reactivate the content with its original start date. When activating with a 

date prior to today, the current step will not generate a Welcome e-mail since this step would have done 
so when it originally started.

If you want activated content to follow the original version of the workflow but want to create a new ver-
sion of the workflow for future activations, click Copy from the Workflow List page to create a new ver-
sion of the workflow. The new version will include the same information as your original workflow (steps, 

durations, assigned users, welcome memo); however, the workflow name has to be different. 
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SYSTEM REQUIREMENTS FOR WORKFLOW MANAGEMENT

Supported Browsers

• Internet Explorer 7.x

Other System Requirements

• Hardware Requirements

o Minimum Processing Power and Memory: 

 1 GHz 

 1 GB RAM 

o Recommended Processing Power and Memory: 

 2.33 GHz or more 

 2 GB RAM or more

• Screen Resolution: 

o 1024 × 768 and higher

• Internet Explorer settings: 

JavaScript is enabled 

Cookies are on

Select the zone for www.zynxhealth.com

Set Automatic prompting for file downloads 
to Enable
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